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About this tutorial
Congratulations on your selection of XMPie uCreate Print for your Variable Data Print (VDP) needs. 

The XMPie EDU Tutorial is a series of tutorials that together will provide a thorough introduction to VDP 
techniques using Adobe InDesign and XMPie uCreate Print.

The EDU Tutorial is divided into different sections to enable you to quickly jump forward or backward to 
find help to learn different aspects of the product functionality:

	z Part 1 - Project planning, preparation and gathering
	| Understanding the project 
	| Checking the available data
	| Checking the available image and text file assets
	| Planning what content objects are needed to achieve the desired outcome

	z Part 2 - Basic VDP job
	| Linking to your data source
	| Placing Text and Graphic Content objects into the InDesign document
	| Managing text copy fitting and dynamic graphic fitting
	| Creating your first VDP output

	z Part 3 - Using rules and logic
	| Introduction to the Rule editor
	| Functions and how to use them
	| Creating rule or logic

	z Part 4 - Introducing more content object types
	| Creating and using Visibility, Style and Text File content objects

	z Part 5 - Barcodes
	| Creating and using print barcodes

	z Part 6 - uImage regular font effects
	| Creating a font-based uImage template with Adobe Photoshop
	| Creating a uImage Document Package
	| Optimization techniques

	z Part 7 - uImage image font effects
	| Creating an image-font-based uImage template with Adobe Photoshop 
	| Creating a uImage Document Package
	| Optimization techniques

	z Part 8 - Using the uImage package in uCreate Print
	| Linking InDesign and uCreate Print to the uImage package

	z Part 9 - Table Content objects and uChart
	| Linking to secondary data sources
	| Table Content objects
	| Adding uChart to the document

	z Part 10 - Working with uProduce
	| Creating Campaign- and Document-packages
	| Uploading packages to the uProduce Dashboard
	| Processing the document on the server
	| Working with Circle
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Target audience
This tutorial is designed to provide basic information, step-by-step instructions, and sample materials for 
self-learning. Should you require more visual assistance, there are accompanying videos available at  
http://campus.xmpie.com/s/uCreatePrint. 

At the end of this Tutorial, there are review questions, and suggested exercises to build on the skills 
outlined in the tutorial.

The content is designed for customers who have bought XMPie uDirect or PersonalEffect and wish to 
learn how to use XMPie's uCreate Print product to create document templates for VDP production.

It is expected that the reader will already have a basic working knowledge of Adobe InDesign. If not, it is 
recommended to first complete some basic InDesign training  for example, courses with Adobe: 
https://helpx.adobe.com/indesign/tutorials.html or a 3rd party organization such as Lynda.com: 
https://www.lynda.com/InDesign-training-tutorials/233-0.html

Document structure
This tutorial uses the following icons to draw your attention to special key items to help you identify the 
information you are looking for when completing the tutorial.

Sections of the tutorial which require hands on action will be highlighted with the following icon.

Step by step instructions

This is an example of step by step instructions.

Reference materials
	z uCreate Print User Guide (Access via the online help link in the Dynamic Content menu).
	z uCreate Print Tutorial videos (Access at http://campus.xmpie.com/s/uCreatePrint)

Prerequisites
This tutorial assumes that you:

	z Are familiar with Adobe InDesign, 
	z have a basic understanding of Excel or text-based data, and
	z have a basic understanding of the aims of Variable Data Print (VDP).
	z have Adobe InDesign CC2023 installed (trial version is acceptable) 

Additional information and notes

This is an example of additional information and notes.

NOTE: Special attention and warning

This is an example of special attention and warning.

http://campus.xmpie.com/s/uCreatePrint
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Module 1: 
Introduction and overview
In this module, we download and unzip the tutorial resource files. We will investigate the provided files, 
and get ready to start work in InDesign.  This overview will also describe what we want to achieve in this 
sample tutorial.

Duration
About 10 minutes

Objectives
After completing this module, you will be able to:

	z Unzip and open a sample InDesign file provided by a colleague or customer, and
	z Describe the text and images in the document that will be made dynamic.

Procedure
Install uCreate Print

If you have already installed uCreate Print, you can skip over this step. This tutorial will require uCreate 
Print version 12.1 or later. 

If you do not have an installer, you can download the trial version from:  
http://www.xmpie.com/trial-software-and-tutorials/.  

You can find the recommended system requirements in the Customer Expectation Document:

https://downloads.xmpie.net/PE/PE-12.1/XMP/Documentation-F98KPS/XMPie%20uDirect%20
CED_v.12.1.pdf

Step by step instructions

On a computer which has Adobe InDesign CC 2023 installed, double-click the uCreate Print 
installer, and follow the prompts to install the application.

If you have a uCreate Print or uDirect license, after installing, license your product by opening 
Adobe InDesign and select Activate license... from the Dynamic Content menu Help group.

Download the sample files

In order to follow along with the steps in this tutorial, you will need to download the document files 
provided in the resources zip file.

Step by step instructions

If you don't already have the zip file of resources that accompanies this tutorial, download it 
from the XMPie Campus website at http://campus.xmpie.com/s/uCreatePrint.

https://downloads.xmpie.net/PE/PE-12.1/XMP/Documentation-F98KPS/XMPie%20uDirect%20CED_v.12.1.pdf
https://downloads.xmpie.net/PE/PE-12.1/XMP/Documentation-F98KPS/XMPie%20uDirect%20CED_v.12.1.pdf
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Unzip and review the contents

Step by step instructions

Unzip the resources package. You should see the following files:

Open the InDesign document

Step by step instructions

Launch InDesign and open the EDU Postcard CC2023.indd file.

If you have problems opening the file, then open the EDU_Static.idml file and Save as... to 
save it as an indd document.

Additional information and notes

XMPie refers to static images, or images that are the same for every recipient in the database 
as Resources. Images (or text files) that will vary based on database rules or logic are called 
Assets. This is why there are two folders of images in the downloaded zip file.
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Re-link images (if necessary)

Step by step instructions

If InDesign prompts you about modified links, 
click to Update Links

InDesign should locate the images automatically. If not, follow these optional steps:

Open the Links panel: Window -> 
Links (Ctrl-Shift-D). 

Select the links that have the caution icon, and select to Relink... the links from the panel 
menu. 

Locate the image of the same name in the resources or assets folder. InDesign should offer 
to relink other images found in the same folder. If not, repeat the process until all images are 
relinked.

Install or replace missing document fonts (if necessary)

The tutorial document uses the fonts Impact and Myriad Pro, which should be automatically installed 
by Adobe InDesign. If either or both fonts are not available on your computer, InDesign will prompt you  
about missing fonts. You can look for them online and install them, or simply replace the fonts with one 
you already have installed. 

Step by step instructions

If InDesign prompts you about 
missing fonts, then click Find 
Fonts... and select to replace 
the missing fonts with one 
already installed on your 
computer.
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Set High Quality display performance

Step by step instructions

From the InDesign 
View menu, 
select Display 
Performance and 
then High Quality 
Display.

Alternatively, use 
the Ctrl+Alt+H 
keyboard shortcut.

Review campaign requirements

Before starting any VDP job, it is recommended to look at the document and the data to understand what 
information you have, and what needs to change in the document. It can also be very helpful to write a 
list of ADORs or content objects that are needed to complete the job.

In this tutorial, we are going to create a postcard inviting prospective students to a university open day.

The invitation postcard document looks like this:
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The data for this tutorial looks like this:

And the available asset images include:

With the document design requirements, data, and assets, we can now define the content objects and 
rules we need to create. Below is the list of tasks for this tutorial. For your reference, each is followed by 

the tutorial page number.

Additional information and notes

ADOR (Automatic Dynamic Object Replacement) is a patented XMPie technology for objects 
that can be dynamically changed or replaced in the document. For example a Text ADOR can 
change text in the document. We also refer to ADORs as Content Objects.
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Front page tasks
	z Connect the InDesign document with the provided data source - page 14.
	z Replace the static name with recipient's FirstName from the database (in two locations) - page 18.
	z Handle copy fitting of long FirstNames - page 20.
	z Dynamically replace the central image with one representing the school the student is interested in. - 

page 24.
	z Handle fitting different size images into the graphic frame - page 27.

Back page tasks
	z Replace static name and address with fields from the database - page 21.
	z Handle empty address lines when address2 field is empty - page 22.
	z Print and review the output by Generating VDP output - page 29.
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Module 2: 
Linking to a data source
Now that the static InDesign document is open, and we have our data source and list of tasks needed to 
create the template, we are ready to get started. 

In this module we will use the Dynamic Content menu to link the document to a data source and then 
take a moment to save our work.

Duration
About 5 minutes.

Objectives
After completing this module, you will be able to:

	z Locate and open the Dynamic Content panel in InDesign,
	z Open and use the Dynamic Content panel, and Dynamic Content menu,
	z Link the InDesign document to a data source.

Procedure
Open the Dynamic Content panel

Step by step instructions

If the Dynamic Content panel is not visible, open it by selecting it from Dynamic Content -> 
Show Window menu.
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Linking to a data source

Step by step instructions

The panel contains a link to uCreate Print training material in 
XMPie Campus.

And, a large button to link to the datasource or plan and start 
making the InDesign document a variable data template.

Click the button on the panel, or select Set input data from the 
Dynamic Content menu.

Select Data Source File and click Next.

Click Browse...

Navigate to and select the 
EDU_201x Prospective 
Students.csv file in the 
tutorial folder.

Click OK.

Additional information and notes

In addition to linking to data sources, uCreate Print can also use

	z A Plan file created by uPlan (which is part of the PersonalEffect server suite of 
tools);  

	z A Counter, which is useful for doing ticketing or other document types where 
a recipient list is not necessary (eg documents created for uStore customization).

	z Or, by manually defining the structure of a data file that you will connect to 
later.
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Select Comma as the field 
separator. Click OK.

You will see a dialog indicating that the document has 
been successfully connected with the data source. 

Click OK.

When you link to a data source, the Dynamic Content 
panel will create Text content objects for each field in 
the data source.

This is now a good time to familiarize yourself with the 
panel. For full details, refer to Appendix A.

Additional information and notes

Later when working on your own documents, you can select the required 
separator from the drop-down list, or simply type the separator character. Also, 
if you later connect with Excel or Access, this dialog gives you the opportunity to 
select the specific spreadsheet or table that you want to connect to.

Additional information and notes

On Macintosh, uCreate Print can connect with .TXT or .CSV (comma separated 
value) text files.  
On Windows, uCreate Print can connect to .TXT or .CSV files as well as Microsoft 
Excel and Access files.
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Save a new copy of the document

In case you want to return to the original document to complete this tutorial again in future, it might be 
helpful to now Save as... to create a new copy of the document.

Step by step instructions

From the File menu, select Save as... 

Name your new file EDU 
Postcard Template.indd.

Click Save.
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Module 3: 
Placing Dynamic Text
Now that we are linked to the data, we can start to place content objects into the document design. 

Duration
About 20 minutes.

Objectives
After completing this module, you will be able to:

	z Place text content objects into the InDesign document,
	z manage copy fitting of dynamic text in the text box,
	z create new text ADORs or content objects, and
	z hide or suppress empty text rows.

Procedure
Showing the Data Column

Sometimes it is helpful to see the values in the data source. For example if the data field or column names 
don't clearly say what it contains.

Step by step instructions

From the Dynamic Content 
menu, select Preferences.
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Check the Show Data 
Column in Dynamic Content 
Panel checkbox. 

Click OK.

The list of Content Objects will how display values 
from the data source.

Viewing different data records

Step  by step instructions

At the bottom of the Dynamic Content panel, you 
can see the name of the data source that you are 
connected to.

Just above this, you can see that the data source contains 1000 records and that the data 
column is showing the values from record number 1.

You can use the up and down arrows next to the record number, or enter in any number 
between 1 and 1000 to view the data of that record in the Dynamic Content panel.

Making static text dynamic

Step  by step instructions

From the InDesign toolbox, select the Type tool 

Select the text Montgomery.

Then in the Dynamic Content 
panel, double-click on the 
FirstName content object to 
place it into the document.
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You will now see the 
document contains another 
name. Assuming that you are 
still viewing record 1, this will 
be Salvador.

On the Dynamic Content panel, use the up and down 
arrows to scroll through the data records to see the 
InDesign document update for the current record.

Repeat the process to place 
the FirstName in a second 
place on the page.

Use the Type tool, select the 
text and double-click the 
content object.

Find the longest First Name

Now the name Salvador fits in the text box, but what happens if there is a really long name in the 
database?

Step  by step instructions

In the Dynamic Content panel, right-click (or Cmd-click 
on Macintosh) on the FirstName content object.

From the menu, select Go to Longest.

Additional information and notes

InDesign has multiple screen modes.  When in Normal screen mode, the uCreate 
Print will highlight dynamic objects in the design. (In Preview screen mode 
highlighting is disabled.) If the highlighting of the dynamic objects is distracting 
you from the document design, you can toggle off the Highlight All Dynamic 
Placeholders setting either from the Dynamic Content menu, or from the menu 
on the Dynamic Content panel.
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In the Dynamic Content 
panel, you will see the 
longest FirstName is 
Lauretta-Leigh which is too 
long for the first text box, 
while it fits OK in the second 
text box.

Dynamic story length handling

Dynamic story length handling allows us to control how text values will be adjusted to fit in the text 
frame.

Step  by step instructions

From the InDesign tool box, select the Selection tool (black pointer) .

Click the first text box to 
select it. Then right-click on 
the selected text box.

From the menu, select 
Dynamic Content and then 
Copy fit...

The Dynamic Story Length Handling dialog 
appears.

Check the box to Copy Fit on Overflow.

Check the boxes to automatically change font 
size and horizontal scaling.

Click OK.
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You should now see the full 
First Name of this recipient 
fits within the text box.

Repeat the process to turn 
on the copy fitting for the 
second text box.

Scroll through some recipient records. You should see 
that uCreate only changes the font attributes if the 
First Name does not fit within the text box.

Page 2 - more text content objects

Step  by step instructions

Scroll down or use the pages panel to move to the second page. 

Use the Type tool to replace 
the static name with the 
FirstName content object.

Additional information and notes

The Dynamic Story Length Handling dialog allows you to control how the text 
within the dynamic text box will be controlled for each recipient. 

If you are dealing with a lot of text, you could use Auto Flow to have text flow 
over to a new page if one recipient will have more text than another.

Alternatively, the Copy Fit option allows you to automatically change the font 
size, horizontal scaling and leading when the text overflows the text box, or 
underflows, or both. 

The Min and Max settings allow you to control the largest percentage (from your 
document defined font settings) that uCreate Print will use to try to fit the text. 
For example on a business card where you already have small text, you would 
not want to reduce font size to a point where it is unreadable, so  you might 
want to increase the minimum to say 90% of your set font size.
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Repeat the process to replace 
each of the name and 
address fields in the address 
block.

Note that some records do 
not have any data for the 
second address row.

Depending on the record you are currently viewing, you may or may not see any value for 
the second address line.

Suppress trailing spaces on empty content

Step  by step instructions

From the InDesign tool box, select the Selection tool (black pointer) .

Click on the address block to select that text frame. 

Right-click on the selected text frame. 

From the Dynamic Content group, select Suppress Trailing Spaces on Empty Content.
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Scroll through some data records to see the behavior. Record 2 has no data in the address2 
field, while record 1 does. So, for the second record, you should see the last line of text move 
up to remove the empty line, but on record 1 where there is data, the last row of text should 
move down.

Additional information and notes

TIP: in this case, the lower lines move upwards when there is empty content. 
Sometimes, you may want the design to have the top lines move downwards, or 
you may want the rows to text to be centered vertically in the text frame. To do 
this, right-click on the text frame and select Text Frame Options... The Vertical 
Alignment setting allows you to control the position of the text in the frame.
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Module 4: 
Placing Dynamic Graphics
When you link to a data source, the columns or fields become Text content objects that can be placed 
directly into the document design as seen in Moldue 3. In this module we look at creating and placing 
Graphic content objects.

Duration
About 10 minutes.

Objectives
After completing this module, you will be able to:

	z Duplicate a content object,
	z change the content object type,
	z set the assets folder,
	z place the Graphic content object into the design, and
	z manage Dynamic graphic properties.

Procedure
Duplicating and editing a content object

For the central image on the front page of the design, we want to display a graphic that is more 
representative of the school the prospective student is interested in. Our Assets folder contains an image 
for each of the schools named by the school name. 

Step  by step instructions

Right-click on the School content object and 
select Duplicate.
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Right-click on the School copy content 
object and select Rename...

Change the Name to School photo.

Right-click on the School photo content 
object and select Type.

Change the Type to Graphic.

The content object's icon will change indicating that 
it is now a Graphic content object instead of a Text 
content object.

Additional information and notes

Notice that we did not need to create any logic to select a specific image if the 
school equaled a specific value. By naming the asset images with the same name 
as each school, there is no need for any logic - the name of the school in the data 
source already equals the school graphic name.

Additional information and notes

Also notice that we did not need to specify any file type extension. XMPie 
features an asset resolution mechanism that is designed to select the right file 
type for different types of production. This means that you can use the same 
graphic content object to change a graphic in print or in web or email.
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Set the assets folder

By default, uCreate Print will look for image assets from the folder containing the data source and any 
subfolders. To ensure that images are found quickly and efficiently, you should set the assets folder to 
specify the right location.

Step  by step instructions

From the Dynamic Content 
menu, select Assets...

Browse to and select the folder named Assets in the tutorial resources folder.

Place the graphic content object into the document design

Step  by step instructions

From the InDesign tool box, select the Selection tool (black pointer) .

Click on the graphic box to 
select it.

In the Dynamic Content 
panel, double-click on the 
School photo content object.

Additional information and notes

If you do not set the assets folder, uCreate Print will look for assets from the 
folder containing the linked data source and any sub folders. Because this folder 
may contain many irrelevant images, it is recommended to set the assets folder 
correctly to improve performance..
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Depending on which record 
you are currently viewing, the 
image may be different.

Dynamic graphic properties

By default, when you place a Graphic content object, uCreate Print assumes that all the asset images are 
the same size, and so what ever scale and crop options you define will be applied to all assets. In some 
cases, your asset images may be in different sizes. To automatically set the "fitting" of the image in the 
image frame, XMPie provides a dialog to control Dynamic Graphic Properties.

Step  by step instructions

From the InDesign tool box, 
select the Selection tool 
(black pointer) .

Click to select the school 
graphic frame. 

Right-click on it and from 
the Dynamic Content menu, 
select Dynamic Graphic 
Properties...

Additional information and notes

You will notice that for some recipients there will be no image displayed. This 
will happen where the data does not have an entry for the recipient's school 
selection. In the next tutorial (Using rules and logic) we will show how to display 
a generic or default image when there is no school.
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Select Fill Proportionally & Centered.

Click OK.

Scroll through some records to confirm that the image is fitting as required for different 
recipients.

Our dynamic template is now complete. 

You should save your work.
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Module 5: 
Your first VDP Output
Our dynamic template is complete. We are ready to create the output file to print. Please note that 
generating VDP output is only possible with a licensed version of uCreate Print.

Duration
About 10 minutes.

Objectives
After completing this module, you will be able to:

	z Create VDP output of one or more data source records, and
	z impose the output for optimized press sheet coverage.

Procedure
Basic variable data print

In this example we use default print settings to create page-by-page output for each record.

Step  by step instructions

From the Dynamic Content 
menu, select Generate VDP 
Output...

If you have not already saved 
the document, you will be 
prompted to do so.
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Set the output Format to 
Adobe(r) PDF.

Set the range of Records that 
you would like to print. I will 
set 1 to 10.

Click OK.

You will see a dialog indicating the print production progress. 

You will see a warning dialog indicating 
that the School photo Graphic content 
object was empty for some records. 

Click OK. We will fix this in the next 
Tutorial.

After a few moments, the dialog will 
close and you are returned to the 
document.

In the folder where your InDesign document is saved, look for a new folder called output. 
Inside the output folder, uCreate Print will create a subfolder with the current date and time 
and save the output file into this folder.

Additional information and notes

For more information on other settings in the Dynamic Print dialog, refer to the 
uCreate Print User Guide by selecting Help > Online Help from the Dynamic 
Content menu.

Additional information and notes

In addition to PDF, uCreate Print can output several other VDP output formats 
including PS, VIPP, VPS, PPML and PDF/VT-1. The best one to use will depend on 
your printer so you should do some tests to see which is smallest/fastest.
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Variable data print with imposition

In this example we output the postcards imposed to a larger sheet size with bleed and trim marks.

Step  by step instructions

From the Dynamic Content 
menu, select Generate VDP 
Output...

If you have not already saved 
the document, you will be 
prompted to do so.

Set the output Format to 
Adobe PDF.

Set the range of Records that 
you would like to print. I will 
set From 1 and To 12.

Click OK.

Additional information and notes

On the Dynamic print dialog, you can also choose to set the Destination. If you 
choose to set a destination, uCreate Print will save the output file in the folder of 
your choice. If you print multiple times with a custom destination, each print will 
overwrite any previous output file in that location.
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Click Imposition.

Set Imposition Template to 
Step and Repeat.

Set Sheet Size to SRA3 
Landscape.

Set both Margin Width and 
Height to 0.08in (or 2mm)

Check Auto Calculate.

Check Duplex.

Check Centre Pages on 
Sheet.

Check Draw Cut Marks and 
enter 0.12in (or 3mm) for 
both x and y values.

Click OK.

When production finishes, check the output folder for a second subfolder, and open the 
output PDF to check your work.

Samples of the first two pages of the PDF output are shown below and on the next page.
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Appendix A - Dynamic Content 
panel
A data table’s columns contain different types of data: ID, FirstName, LastName, School, etc. 

The table’s column headers are known as fields and each row contains the data for a record.

 

When you link to a data source table, uCreate Print automatically creates a Text content object for each of 
the table’s column headers. 

When you edit your document design with uCreate Print, you use simple point-and-click operations 
to tag different design objects, such as a text frame or graphic frame, with the desired type of content 
object; for example the First Name text content object or the school Image graphic content object. 
Such a tagged design object becomes a dynamic object: a design object that derives its content and/or 
appearance from the content object’s value.

The Dynamic Content panel lists the Content Objects created for the column headers of the linked data 
source:

 The populated Dynamic Content panel shows the following details and options:

	z Show Content Objects, Variables or Input Data Fields—While content objects are available to place 
into the document design, variables are used behind the scenes. Variables use the same kind of 
business rules or logic that we used for content objects in this tutorial. Variables are useful to calculate 
a value once – you can then use that variable in several content objects instead of having to calculate 



the value each time. Input Data Fields are the fields or columns expected to be found in the data 
source linked to the document.

	z Filter View —Use the View drop-down list to show All Types of content objects, or to filter the list to 
show a specific type (e.g., Text, Graphic, Visibility etc.).

	z Filter Groups —When connected to a plan file, uCreate Print can filter the list of content objects by the 
group that contains them. Like folders, groups can help sort content objects into logical categories.

	z Content object list—lists the names and types of the content objects available to place into the 
doucment. These include content objects automatically created when you link to a data source, or 
have created manually.

	z Proofing options—uCreate Print offers you a number of ways to check what your dynamic document 
will look like when actual values are used in place of the dynamic objects. These actual values can 
come from various types of content sources, including your data source, a proof set file or content 
samples.

	z Browse to data source —This option allows you to connect to a different datasource. The functionality 
is the same as using the menu to select Dynamic Content > Link to Data > Datasource...

	z Dynamic Visibility—Opens the dynamic visibility dialog, so you can assign a visibility content object 
to the active spread or active layer (Note that the icon is the color of the active layer). When dynamic 
visibility is assigned, an eye symbol is added to the respective icon (e.g. ).

	z Record selector—used to proof your dynamic document: browse through the records of your content 
source (the linked proof set, a content sample or the linked data source), and see how the dynamic 
objects’ value changes the document when you scroll from recipient to recipient.

	z Resize panel—to see the complete list of content objects, resize the panel by dragging its bottom 
right corner. Alternatively, use the horizontal scroll bar to scroll down the list.
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Review and extra exercises
To consolidate your understanding of the topics covered in this tutorial, please answer the following 
review questions, and complete the additional exercises:

Review questions
What kind of data source files can you connect to uCreate Print? (Page 15)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

What type of content objects are created when you link uCreate Print with a data source? (Page 15)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

When you are selecting text to apply copy fitting, do you use the Type tool, or the Selection tool? (Page 
18)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Content objects can only be data source fields. True or false? (Page 24)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                     

Image assets for Graphic Content object must all be the same size. True or false? (Page 27)  .  .  .  .  .  .  .  .  .        

From which folder will uCreate Print search for assets if you don't set the assets folder? (Page 26)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

What print output formats can uCreate Print produce? (Page 30)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Additional exercises
Exercise 1

Take an existing InDesign document used in your company (for example a business card) and create a 
data source in Excel or CSV to contain all the data fields necessary for the document (firstname, lastname, 
address, phone, fax, email, etc). Enter a couple rows of data representing some of your colleagues and 
convert the static InDesign document to a dynamic template.
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